## Contents

1. Welcome to COPA-DATA help ........................................................................................................... 5
2. Distributed engineering ....................................................................................................................... 5
3. Hardware requirements ....................................................................................................................... 7
4. Information about SQL Server ......................................................................................................... 7
5. Possibilities of the multi-user administration .................................................................................. 8
   5.1 Local Server ................................................................................................................................... 8
   5.2 Local severals to which several clients access ............................................................................... 8
   5.3 Access server with multiple clients ............................................................................................... 9
6. Creating a new multi-user project .................................................................................................... 10
7. Convert single-user projects to multi-user projects ......................................................................... 12
8. Converting multi-user project to single user project ........................................................................ 12
9. Working with a multi-user project ................................................................................................... 13
   9.1 Extend and synchronize project .................................................................................................. 13
   9.2 Changing existing elements ....................................................................................................... 15
   9.3 Deleting projects ......................................................................................................................... 16
   9.4 Disconnect client ......................................................................................................................... 16
   9.5 Backup mechanism ...................................................................................................................... 17
      9.5.1 Project backup ..................................................................................................................... 18
      9.5.2 Restore project backup ........................................................................................................ 18
   9.6 Allow, accept and reject changes ............................................................................................... 19
      9.6.1 Status of the elements and the modules .............................................................................. 21
      9.6.2 Keys of the symbols ............................................................................................................. 23
   9.7 Deleting elements ....................................................................................................................... 24
   9.8 Synchronization of the multi-user project ................................................................................... 25
   9.9 Recipegroup Manager .................................................................................................................. 26
   9.10 VBA and VSTA ............................................................................................................................ 26
   9.11 Close the Editor ........................................................................................................................... 27
9.12 Style groups and styles................................................................. 28

10. Working offline .................................................................................. 28

10.1 Switch offline ................................................................................... 28
   10.1.1 Elements/modules are locked by another user .................................. 28
   10.1.2 Elements/Modules are checked out by the same user during offline switch ........................................ 28
   10.1.3 No elements/modules are checked out during going offline .................... 29

10.2 From offline to online ........................................................................ 29

10.3 Possibilities in offline operation.......................................................... 30
1. Welcome to COPA-DATA help

ZENON VIDEO-TUTORIALS

You can find practical examples for project configuration with zenon in our YouTube channel (https://www.copadata.com/tutorial_menu). The tutorials are grouped according to topics and give an initial insight into working with different zenon modules. All tutorials are available in English.

GENERAL HELP

If you cannot find any information you require in this help chapter or can think of anything that you would like added, please send an email to documentation@copadata.com (mailto:documentation@copadata.com).

PROJECT SUPPORT

You can receive support for any real project you may have from our Support Team, who you can contact via email at support@copadata.com (mailto:support@copadata.com).

LICENSES AND MODULES

If you find that you need other modules or licenses, our staff will be happy to help you. Email sales@copadata.com (mailto:sales@copadata.com).

2. Distributed engineering

The Multi-user-function of zenon makes it possible, that multiple users concurrently work at the same project. For this, the projects are stored on a central SQL Server (on page 7) and can be worked on from
different workstations at the same time. The central storage of the project will be called **Server DB** in the following text.

**For example:** One user creates the screens while another one can concurrently define the variables.

---

### Information

*Hint for terminology:*

"Check in" equals property **Accept changes**

"Check out" equals property **Enable changes**

---

### IP PROTOCOL

The communication in the zenon network can be done via IPv4 or IPv6. For details see the Network manual, Requirements chapter.

---

### License information

*Part of the standard license of the Editor and Runtime.*
3. Hardware requirements

The minimum requirements relate to the use of multi-user projects with a number of objects (for example >= 100,000 variables).

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Minimum requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Quad Core</td>
</tr>
<tr>
<td>RAM memory</td>
<td>Server: 16GB / Client: 8GB RAM</td>
</tr>
<tr>
<td>Harddisk</td>
<td>SSD is recommended</td>
</tr>
</tbody>
</table>

Note: The Maximum Server Memory setting of the SQL server may need to be amended manually.

Information

You can find more information under the following link:

4. Information about SQL Server

ZENON FROM VERSION 7.00 SP0 ON

For distributed engineering all participants access a central SQL Server. From zenon version 7.00 SP0 on all participants must use version 7.00 or higher:

- Editor: from 7.00 SP0 on
- DBSrv: from 7.00
- SQL Server: SQL Server 2008 R2 Express Edition

Attention

The same password must be used on all computers.

Attention: The encryption is done via the Startup Tool. Therefore you must carry out the database setting via the Startup Tool.
The password must also be amended on the SQL server for the zenOnSrv user.
UPDATE

When updating the project server to SQL Server 2012 Express, all Clients must also be updated.

5. Possibilities of the multi-user administration

The multi-user administration can be used for:
- Standalone (on page 8) in order to test changes without risk
- a local Server (on page 8) with several clients
- a network Server (on page 9) with several clients

5.1 Local Server

In this case the server project AND a local project copy are stored at the same PC.

It is possible to create multi-user projects on one single computer. This makes for example sense when you want to check changes first. To do this e.g. changes are allowed for a screen, it is edited and tested in the Runtime. After this the changes can be checked in or rejected. The original screen stays unchanged, until the changes in the screen are accepted.

5.2 Local several to which several clients access

The server database and a local project copy are on one PC. The clients also work with a local project copy. Changes in the local project copy are transferred to the server database, when the changes are accepted. On the server computer also a local project copy is edited.
5.3 Access server with multiple clients

The server database is on the central computer. Multiple Clients connect to this server. Local project copies are created on each client.

Local project copies 1-3 of the Server DB

**Information**

Various configurations of the example above are also possible. E.g. each computer has one or more server databases for different projects and at the same time only one local project copy of another server database.

**SERVER WITHOUT LOG INS**

For Servers in which no user is logged in, the `zendbsrv.exe` must run as a Service.

The `zendbsrv` service starts the `zensyssrv` service for logging tasks. For the operating system Windows 7 this is not permitted via Remote Transport due to security reasons. The file must to be registered manually:

```
zendbsrv.exe -service
```

**Hint:** Also register file `zensyssrv.exe` as service: `zensyssrv.exe -service`

**Information**

As soon as both files are registered, it is no longer possible to use Remote Transport from Windows 7 or higher, i.e. Remote Transport cannot be started via Runtime.
6. Creating a new multi-user project

When a new project is created, the checkbox Multiuser project has to be activated. Enter or select the server for the multiuser project in the field Project server. If a server is selected, the checkbox Multiuser project is automatically activated.

If no server is selected in field project server, the project, i.e. the server database, is created on the local PC. A local project copy is created automatically with which you can work directly in the Editor.

REQUIREMENTS:

- Project database server (zendbsrv.exe) must be started on the server and the client
- Firewall setup:
  - you must unblock the programs zendbsrv.exe and sqlservr.exe.
  - SQL browser must be enabled for the Server and the Client.
- Necessary open ports:
  - 1103
1433 for SQL Server: this port can change therefore the SQL Server process must be taken out completely from the firewall

1434 for SQL Browser

- The name resolution in the network must work
- Reverse lookup must deliver the same computer name both at the server and at the client

**Attention**

Workspaces do not support multiple users because they are station-specific. So the project hierarchy can be defined differently on different computers. The users have to communicate directly so that the hierarchy is the same on all stations.

## Creating a Client for a Multiuser Project

Execute the following steps in order to create a client for a multiuser project:

1. Select `File from -> Add existing project ...

   The **Project selection** dialog to select a project is opened.

2. In this dialog, select the name of the computer under **Computer name**.
   To do this, enter the name of the desired computer in the network or click on the ... button to show a list of computers in your network. Please note that the reading of the computer list via the ... button can take some time depending on the size of your network.

3. After selecting or entering a computer name, the **project selection** list is updated.
   In this list, all zenon projects available on the computer are listed.

4. Under **Project selection**, select from the list of available projects the project that you want to integrate on your local computer in your zenon **Workspace**.

5. Confirm your selection by clicking on the OK button.
   The project is listed in your zenon **Workspace**.

## Notes on Configuration with Zenon Logic

Note when configuring with zenon Logic:

- In the zenon Logic Workbench, lines can be created in the **All projects** node **MultiSpy** and the global **Binding** Editor can be called up. The following is applicable for these settings: They are
  - Not saved as multi-user
  - Not transferred to the project server
  - Removed again in the next synchronization

- If new zenon Logic projects are created in the zenon Logic Workbench via `File -> Add new project`, the following is applicable: They are
  - Not transferred to the project server
• Deleted again in the next synchronization

Attention: Multi-user zenon Logic projects can only be created using the zenon Editor.

7. Convert single-user projects to multi-user projects

To convert a single-user project to multi-user project:

1. Make sure that the global project is a multi-user project.
   If this is not the case, remove the existing global project from the workspace and create a new multi-user global project via the context menu of the workspace. Project new

2. Then convert the single-user project: in the context menu select menu item Multi-user -> Convert to multi-user project

3. You receive a warning that you cannot undo this step.
   You can however create (on page 12) a single-user project from a project backup of a multi-user project.

4. Confirm the warning by clicking on Yes.

Information

At the conversion the computer on which the action is carried out is defined as the database server for the project. This property cannot be changed later.

8. Converting multi-user project to single user project

To convert a multi-user project to single-user project:

1. Make sure that all project changes are taken over by all clients:
   • Project -> Context menu -> Multi-user -> Synchronize

2. Create a project backup:
   • Node project backup -> Context menu -> Create backup
   • Enter a name and a description in the dialog. You can also backup a local project copy.

3. Create a new project from the backup:
   • Workspace -> Context menu -> Restore project backup.
   • Select the desired project backup.
• Activate checkbox **Create new project**.
• Confirm your selection by clicking **OK**.
• Enter a new project name.

4. The project is created as single-user project. The multi-user project also still exists.

**Note:** To convert the local project copy to a single-user project, you can also select option **Project -> Save as ...** in the Editor.

### 9. Working with a multi-user project

Multi-user projects enable access to all modules. Things to consider when engineering multi-user projects are:
- the options, Enable changes and Accept changes (on page 19) and their handling of changes in several modules
- Deleting (on page 24) elements
- Synchronizing (on page 25) elements
- the exceptions of VBA (on page 26) and RGM (on page 26)

**RENAME PROJECT**

Projects cannot be renamed locally with the **Save as** command, because it is always the local project copy that is always saved.

To save a server project under a new name:
1. Make a backup of the server project.
2. Select **Restore backup as a new project** in the context menu.
3. Enter the new chosen name.

The project is now available with a new name.

#### 9.1 Extend and synchronize project

If a new element (e.g. a variable or a screen) has been created, this element first is only available locally and changes are automatically allowed.
If the changes are accepted, another client must synchronize so that the changed elements are also available on his computer.

If after creating a new element the changes are rejected, it is, as if the element never had existed.

The difference between a new variable and a new screen is, that after a synchronization the variable is not visible on the other computers, if the changes have not yet been accepted. After a synchronization the screen is visible as under construction on the other computers.

See also chapter Screens / Frame editor.

After another user has added or deleted an element, the project has to be synchronized in order to receive the changes. This is done with the entry Project/Synchronize in the context menu of the project.

The following configurations can be done in this context menu:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multi-user/synchronize</td>
<td>The project is synchronized.</td>
</tr>
<tr>
<td>Multi-user/activate offline mode</td>
<td>The offline mode (on page 28) is activated. Changes take effect only locally and are not taken over centrally as long as the project remains offline.</td>
</tr>
<tr>
<td>Multi-user/activate online mode</td>
<td>The online mode (on page 29) is activated. If elements have been edited and taken over by other users in the meantime, they overwrite changes from the offline mode.</td>
</tr>
<tr>
<td>Update local version</td>
<td>The local copy is updated with the Server DB. The project is reloaded into the Editor. <strong>Attention:</strong> Exception: The Elements/Modules, that are checked out by this user.</td>
</tr>
</tbody>
</table>

Information

The elements that have been checked out by the same user, that has done the synchronization, will not be overwritten by the synchronization. The local changes are protected from overwritten by the check out status.

**Exception:**
User A checks out elements offline. User B checks out elements online. If user A reconnects to the server, the elements checked out by both users are overwritten with the data of user B. If from a team one member is out of office, we recommend not the change the project in this offline phase!
9.2 Changing existing elements

If changes to an element are required, it must first be checked out. This prohibits more than one user gaining access to the same element. Elements that are checked out cannot be changed by other users.

The Element can only be changed by the user that has it checked out. This user has the exclusive change rights. For all other users this element is prohibited and locked.

In order to allow changes at an element, the user has to select "allow changes" in the context menu of the element. It is possible, to check out only single elements, e.g. one variable. To do this, select the single variable in the detailview and select entry Allow changes in the context menu. It is also possible to check out all variables in the project at once via the module node.

If a project is a multi-user project the entry **Under construction** is added to the Project Manager. In the detail view, the elements of the current project are listed. The default columns are: Status, Element, Target and Module. Additional columns can be added in the context menu of the column headers with the entry 'field selection'. With the additional columns, the list shows an overview of which elements have been edited by which user and on which computer.

An element/module can only be 'read' but not edited, as long as the user has not fetched the authorization for it. The authorization can be fetched with the context menu of the element **Allow changes** or directly at opening the element.
9.3 Deleting projects

If a project is deleted, only the local project copy is deleted. The server DB remains available and other clients can still work with it. It is still possible to add the project to the workspace. Here a new local project copy is created again.

If a user deletes his local project copy, all check out information and thus all changes of this user are lost.

9.4 Disconnect client

With the functionality disconnect client it is possible to disconnect the local project copy of an user from the server database. So all check out information of this user is deleted. Changing the elements locked by this user again is possible.

It can be necessary to disconnect a client, if the user is not in the office and has checked-out elements, which urgently have to be edited or the computer of this user is defective.

⚠️ Attention

If the client of an user has been disconnected and the this user opens the project copy, the project is offline. It is no longer possible to go online. First the local project copy has to be deleted and again copied from the server.

REQUIREMENT:

A client can only be disconnected, if the computer, where the local project copy has been edited, cannot be reached.
With the main menu File -> Insert existing project the Project Database Manager can be opened. Under multi-user and connected local project copies you will find all users, which have (had) a local project copy.

With disconnect the entry for this user is deleted from the server database. After the client has been disconnected, the dialog can be closed.

⚠️ **Attention**

This action cannot be undone! If the user on this computer again wants to access the multi-user project, the local project copy has to be deleted and again be inserted.

### 9.5 Backup mechanism

In general, the following should be noted for the backup mechanism with distributed engineering:

- Only local project states can be backed up.
- As long as they have not been synchronized, restoring is also possible.
9.5.1 Project backup

The project backup is executed in the project manager in the node Project backups.

Project backups of local project copies

A project backup can be made using the context menu of the Project backups module. To make a local project backup, the Create local project copy check box must be activated in the Save project backup dialog box.

Local project backups can only be made within the same offline session as the backup.

Information

You can find further information in the project backup manual in the Project backup detail view tool bar chapter.

Project backup of server projects

A backup of a server project can be executed from each client, if the checkbox Save local project is not active.

Information

You can find further information in the project backup manual in the Back up and export project chapter.

9.5.2 Restore project backup

A project backup can be restored using the context menu of the Project backups module.

Local project restores can only be carried out within the same offline session as the backup.

Information

You can find further information in the project backup manual in the Project backup detail view tool bar chapter.
Restore project backup of local project copies

Restoring a local project copy is only possible, as long as no synchronization has been executed. If a project has been synchronized since the last backup, the user only has the possibility to Restore backup as new project. Thus the project is restored as a single user project.

Information

You can find further information in the project backup manual in the Restore project backup chapter.

9.6 Allow, accept and reject changes

To make changes to a project, the respective elements (functions, variables, screens, ...) must be enabled for change (Enable changes). After editing, the elements must be protected from change and must be transferred to the Server (Accept changes).

Note: New and deleted elements are always transferred at the next synchronization. If the user deletes an element, it can still be edited on another computer. However it is finally deleted after the next synchronization.
### Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Update local version</strong></td>
<td>If other users made changes in the server project, the local project copy can be updated with the menu entry. Updates only single existing Elements/Modules. New elements at the Server are therefore not available, synchronization is required.</td>
</tr>
<tr>
<td><strong>Enable changes</strong></td>
<td>In order to be able to change elements, the status ‘Allow changes’ has to be activated. This can be done in the context menu of the selected element. In order to work quicker, the user can enable changes for the whole variable module. This means that all variables, drivers and data types are locked for all other users.</td>
</tr>
<tr>
<td><strong>Accept changes</strong></td>
<td>The changes are transferred into the server project. The element/module is then unlocked for other users. If changes were allowed for a complete module, they only can be accepted for the complete module. This means, that all variables, drivers and datatypes are transferred and unlocked for other users. Accepting a single element is not possible in this case. The changes in the local project copy are rejected and overwritten by the server data. The element/module is then unlocked for other users.</td>
</tr>
<tr>
<td><strong>Undo changes</strong></td>
<td>All variables, drivers and datatypes are rejected and unlocked for other users. Rejecting a single element is not possible in this case.</td>
</tr>
</tbody>
</table>

#### All modules

- **Update local version**: Updates the local version.
- **Enable changes**: Enables changes.
- **Apply changes**: Accepts changes made.
- **Undo changes**: Rejects changes made.

---

**Information**

When you change the project name, **Undo changes** is not possible. The changed project name remains.

---

**CHANGES ON SEVERAL MODULES AT THE SAME TIME**

If a module is enabled for changes and if elements of other modules are newly created and linked with this module, all affected elements/modules must be set to **Accept changes**. Enable the newly created elements/modules first and then enable the already existing ones. If the user enables the module which was originally disabled, recent changes may be lost.

**Example:**

- On one Client the RGM is checked out.
- A new recipe group is created. Then a new recipe.
- An existing variable is added to the recipe group.
- Three new variables are created and added.
- Interlockings are checked out and a new interlocking is added.
- A new keyboard screen is created with a new frame.
- In the recipe group the new created interlocking is assigned.
- The keyboard screen is assigned.
- A new variable for the visibility is created and linked with a variable in the recipe group.

If only the recipe group is set to **Accept changes** and another Client is synchronized:

- the other Clients gets:
  - a recipe group with a linked variable
  - and a recipe which contains the variable
- all other information is lost

If this Client disables, edits and enables the recipe group, all newly engineered information is lost.

For correct acceptance **Accept changes** must be carried out for:

- RGM
- Recipe group
- Recipe
- Variables
- Interlockings
- Keyboard screen
- Frame for keyboard screen

### 9.6.1 Status of the elements and the modules

If an Element has been checked out, the Symbol in the project manager or the detail view changes. The user who has checked out the element gets a checkbox with a green check mark displayed. All other users get a checkbox with a red \( \text{x} \). The \( \text{!} \) symbol means that single elements within a module are checked out.

See chapter Legend (on page 23).

In the special case of the variable administration, symbols have a slight transparency, if the module has been checked out.
Example

All variables are checked out by a user. Another user cannot change these variables, but can add an additional variable.

*Exception: Module checkout*

The following actions are only possible if the whole module is set to **Enable changes:**

- creating array variables
- creating structure data types
- copying and pasting array and structure variables
- creating variables based on a structure data type with array
- changing the array settings of a variable
- changing array settings in zenon Logic of a variable with zenon profile

**Information**

*If a variable is created without the whole module Variable set to **Enable changes**, the dimensions are automatically set to 0. This prevents creating a structure variable unintentionally.*

The following elements/modules can only be set to **Enable changes** or **Accepts changes** as a whole:

- Archives
- Users
- Menus
- Reaction matrix
- Standard recipes
- Recipegroups
- Scripts
- Fonts
- Interlockings
- Allocations

**DISPLAY CHANGED ON DATE IN THE DETAIL WINDOW**

In the detail view there are two columns available which display information about the last changes that were made:

- **Last change accepted:** Displays in all lists regarding distributed engineering, the time of the last update in the database or of the last check in.
- Last modified: Displays a time stamp of the last change to the files.

If the columns are not displayed, you can activate them:

1. Right-clicking on the column header.
2. In the context menu select menu item **Column selection**. It depends on the module which columns are available.
3. Select the desired columns in the selection list on the left-hand side (multi-select is possible)
4. Add the columns by clicking button **Add** - to the right-hand list
5. The Up and Down buttons allow the user to select the desired position
6. Confirm and close the dialog by clicking **OK**.

### 9.6.2 Keys of the symbols

The following symbols indicate the status of the elements in multiuser projects.

(for example: A screen can be changed by a user [ ] )
ELEMENTS IN THE DETAIL VIEW OF THE PROJECT MANAGER:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Symbol]</td>
<td>New element has been added in the local project copy. This is only transferred when <strong>checking in</strong> (Check-In) the element on the server.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>New module has been added in the local project copy. This is only transferred when <strong>checking on</strong> (Check-In) the module on the server.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Elements have been marked as deleted in the local project copy. This is only deleted when <strong>checking in</strong> (Check-In) the element on the server.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Module has been marked as deleted in the local project copy. This is only deleted when <strong>checking in</strong> (Check-In) the module on the server.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Element can be edited by the current user.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Module can be edited by the current user.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Element is locked by another user.</td>
</tr>
</tbody>
</table>

DISPLAY IN THE PROJECT TREE:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Symbol]</td>
<td>Module can be edited by the current user.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Module is edited by another user and thus is locked for the current user.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>At least one element of the module is marked for editing (not the entire module).</td>
</tr>
</tbody>
</table>

9.7 Deleting elements

Data base elements are only displayed as deleted at first. At the other clients no more changes can be done to these elements, the are displayed as “locked”. If “accept changes” is selected, the elements are finally deleted. It is possible to undo the deletion with "undo changes".

**Example**

*This is true for variables for instance: The changes have to be accepted to allow deleting.*

File elements such as screens, files (language table, graphics) etc. are directly deleted when a confirmation is done on the executing computer. New and deleted elements are always transferred at the next synchronization. If you delete an element, it can still be edited on another computer. However it is finally deleted after the next synchronization.
9.8 Synchronization of the multi-user project

After another user has added or deleted an element, the project has to be synchronized in order to receive the changes. This is done in the context menu of the project with the entry Project -> Context menu -> Multi-user -> Synchronize or All modules/update local version.

The following options are available in the context menu:

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Synchronization** | The local copy is updated with the Server DB. The project is reloaded into the Editor.  
**Attention:** Exception: The Elements/Modules, that are checked out by this user. |
| **Update local version** | See synchronize                                                                 |
| **Enable changes**  | Checks out Elements/Modules                                                 |
| **Accept changes**  | Checks in Elements/Modules                                                  |
| **Undo changes**    | The changes of the element are not accepted but discarded. After **Undo changes** the project is overwritten by the Server database again.  
**Attention:** If **changes are undone** at an element that has not yet been "accepted", the changes that depend on this element are also undone. |

New and deleted elements are always transferred at the next synchronization.

Information

The following are ignored during synchronization:

- Elements and modules that are checked out by the same user who is carrying out the synchronization.
- Empty folder.  
  A folder must contain at least one element in order to be synchronized. An empty folder is created, for example, in the Help folder if a new language is added to the language file.
9.9 Recipegroup Manager

FILTER DIALOG IN THE RUNTIME

If you activate property Show dialog in the Runtime at the options of the Recipe value list in the screen switch, there are only restricted options available in Windows CE:

- Recipe Filter
- Column settings (for recipe table)

Recipe selection, Equipment modeling and column settings for the recipe list are not available.

9.10 VBA and VSTA

Select the entry Open VBA Editors or Open VSTA Editor in the context menu of Programming interfaces, then the Editor is checked out and changes are enabled.

Attention: In general in VBA changes are possible even if the element has been set to Enable changes on another computer. Therefore consider the following before making changes via VBA:

1. before you take over changes: check whether you are dealing with a multi-user project
2. if yes: check whether the element is added by another Client
3. if yes: check whether the element has the local status Enable changes (check out)
   a) if yes: the object can be changed,
   b) if no: the object must be set to Enable changes
      - check again whether the object has the Enable changes status
      - if yes: the object can be changed in VBA
4. after the changes the object must be set to status Accept changes (check in) via VBA

Attention

In multi user projects the VBA Editor must not be opened with Alt+F11. If VBA is not checked out, changes are not accepted. When the VBA Editor is opened, a warning message is displayed that indicates which projects are affected.
9.11 Close the Editor

Each user should accept the changes of his objects before closing the Editor, the workspace or the project. As long as this has not happened, other users cannot edit these objects. See also chapter Editor / Closing the Editor. Closing the Editor.

If you close without accepting the changes, a dialog for accepting or refusing the changes is displayed:

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List field elements</td>
<td>Lists all elements which are disabled for editing. Changes for the displayed elements can be accepted or discarded via the respective button.</td>
</tr>
<tr>
<td>Accept changes</td>
<td>The changes of all elements are accepted.</td>
</tr>
<tr>
<td>Undo changes</td>
<td>The changes of all elements are discarded.</td>
</tr>
<tr>
<td>Edit...</td>
<td>Closing is cancelled.</td>
</tr>
<tr>
<td>Next</td>
<td>Continues the closing process for the current project. The elements remain disabled for the other users. If several Multi-user projects should be closed, this dialog is displayed for the project which should be closed next.</td>
</tr>
<tr>
<td>Next (all)</td>
<td>Continues the closing process for all Multi-user project in the workspace which should be closed. The elements remain disabled for the other users.</td>
</tr>
<tr>
<td>Help</td>
<td>Opens online help.</td>
</tr>
</tbody>
</table>
9.12 Style groups and styles

Changes are always enabled for complete style groups only, and not for individual styles. If a style is edited or added in a checked-in style group, a corresponding message for whether changes are to be enabled for the style group is given.

Style groups created from elements or added copies of style groups are not automatically checked out after creation or copying.

10. Working offline

While working offline there is no connection to the server, e.g. when the engineer takes the project with him on the laptop.

To switch a project offline, the entry Activate offline mode has to be selected in the context menu of the project. Projects having no connection to the database server will be activated offline automatically.

Information

*Accept changes and Reject changes is not possible during the offline operation.*

Only Allow changes is available in offline mode, otherwise no changes would be possible in offline operation. Accept changes can be activated in the online period.

10.1 Switch offline

There might be different circumstances when switching offline

10.1.1 Elements/modules are locked by another user

At the moment of switching offline another user edits the element/module. In this case no changes can be done offline.

10.1.2 Elements/Modules are checked out by the same user during offline switch

At the moment of switching offline the same user edits the element/module. In this case no online changes by another user are possible.
10.1.3 No elements/modules are checked out during going offline

At the time of switching offline no elements/modules are checked out.

**CASE 1:**

Offline changes for an element/module are allowed, but the same is also possible online.
User A changes an element/module offline, user B online.
When user A goes online, it is recognized that user B is just editing the module/element online.
The changes made by user A are lost.

⚠️ **Attention**

*In this case the changes made offline (by user A) are lost!*

**CASE 2:**

When user A accepts his changes, user B already accepted his changes.
The changes made by user A overwrite the changes made by user B when going online.

⚠️ **Attention**

*In this case the changes made online (by user B) are overwritten!*

10.2 From offline to online

To switch an Offline-project online again, the entry Project/online has to be selected in the context menu. The project is reloaded into the Editor immediately.
10.3 Possibilities in offline operation

| Elements/modules | Create, change, rename, delete |